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1 Overview  

This document provides an overview of how to build custom lens DLLs, which allow customers to 
create their own command and control drivers. To understand the content of this document, readers 
should have familiarity with custom ARM development, as described in either EAN-ARM-Development-
1500-3000-OEM or EAN-ARM-Development. 

This document covers the following topics: 

• Compiling custom DLL based on SLNopLens (No Op) template. 

• Deploying DLL onto target hardware. 

• Using SightLine Command and Control (directly or via Panel Plus) to configure serial ports and load 
@DLL. 

• Using SightLine Command and Control to communicate with the DLL to drive the lens such as zoom 
in and out and focus. 

• Custom Autofocus 

Fundamentals of lens control as well as specifics on using existing lens DLLs can be found in EAN-Lens-
Focus-Control. 

1.1 Additional Support Documentation  

Additional Engineering Application Notes (EANs) can be found on the Documentation page of the 
SightLine Applications website.  

The Panel Plus User Guide provides a complete overview of settings and dialog windows. It can be 
accessed from the Help menu of the Panel Plus application. 

The Interface Command and Control (IDD) describes the native communications protocol used by the 
SightLine Applications product line. The IDD is also available as a PDF download on the Software 
Downloads page. 

1.2 SightLine Software Requirements 

 IMPORTANT: Starting with 3.6.x software and above, only the 4000 and 1700 platforms will be 
supported. The 1500 and 3000 platforms will continue to be supported in 3.5.x software. Some 
features in 3.6.x and above may not be available on 1500 and 3000 platforms. 

 IMPORTANT: The Panel Plus software version should match the firmware version running on the 
board. Firmware and Panel Plus software versions are available on the Software Download page. 

1.3 Application Bit Requirements    

The functions described in this EAN require Application Bits (app bits) purchased from SightLine. App 
bits are enabled with a license file provided by SightLine at initial unit purchase or during a license 
upgrade process. License files use a hardware ID that is applicable to a specific hardware serial 
number. For questions and upgrade support contact Sales.  

Table 1: Application Bits Requirement Table 

Function  Initial Software Release Required Application Bit(s) v7 License 

Focus Telemetry 2.21.xx  Focus Telemetry 0x0000 1000  

http://sightlineapplications.com/wp-content/uploads/EAN-ARM-Development-1500-3000-OEM.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-ARM-Development-1500-3000-OEM.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-ARM-Development.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-Lens-Focus-Control.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-Lens-Focus-Control.pdf
https://sightlineapplications.com/documentation/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/releases/IDD/current/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/downloads/
mailto:sales@sightlineapplications.com
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1.4 Third Party Software 

Tera Term (or PuTTY): SightLine recommends Tera Term for troubleshooting, debugging, and issuing 
commands on SightLine hardware. 

2 Hardware Configuration 

An example of a hardware configuration with the 4000-OEM is shown in Figure 1.  

 All OEM hardware platforms have a similar hardware and lens configuration.  

 

Figure 1: Example 4000-OEM with Camera and Lens Configuration 

 

3 Lens Control Functionality 

The interface that all lens DLLs must meet is defined in sllens_public.h. A summary of the key functions 
is shown in Table 1. For a complete description and examples see the source code provided with the 
examples. 

  Table 2: Key Functions 

Function Description 

Initialize Called when the lens DLL is loaded and can be used to start thread, initialize variables, etc. 

Cleanup Called when the lens DLL is unloaded. It can be used to clean up cleanly exit threads, close comm ports, etc. 

ConfigureSerialPort Called shortly after Initialize and can be used to configure comm ports. It sets the port number of the Lens. 
As of version 3.6.4, this should not open a serial port from within the Lens DLL. 

 

 

 

Video 

Lens Command and Control 

12VDC (J50) 

4000-OEM +           
SLA-3000-CL 

 

RJ45 Ethernet (J4)  

Camera Command and Control 

(J6) 
Camera Body Camera Lens 

 IMPORTANT: Disconnect all input power to OEMs and 
adapter boards before connecting or disconnecting cables. 

3.3VDC to RS-232 

12VDC  12VDC  

https://ttssh2.osdn.jp/index.html.en
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(Key Functions table continued) 

Get com port/ release 
com port functions 

These six functions are responsible for acquiring and releasing the read and write comports associated with 
the lens serial port number defined in ConfigureSerialPort. When working with a single read-write port, 
utilize GetComPort/ReleaseComPort. However, certain lens implementations may require separate 
handling of the read and write ports, in which case the functions GetReadComPort/GetWriteComPort are 
available. It is crucial to release the com port after use within a specific scope, as failure to do so will result 
in subsequent attempts to use it being unsuccessfu. 

ConfigureI2C Currently not called, but it can be used to configure the I2C bus. The setup is similar to the 
ConfigureSerialPort function. This function is defined in the sllens_public.h header as a no-op. It does not 
need to be implemented by a custom DLL unless I2C is required for camera communications. 

GetZoomRange Gets the lens ranges for zoom to be returned in the LensRanges SVP packet. This must be implemented for 
the Panel Plus lens GUI slider bars to work correctly. 

GetFocusRange Gets the lens ranges for focus to be returned in the LensRanges SVP packet. This must be implemented for 
the Panel Plus lens GUI slider bars to work correctly.  

ZoomStop Sends the command to stop the lens zoom motor. This is called in response to an SLALensCommand.  

ZoomWide Sends the command to zoom out, with an optional argument for the motor speed. The speed argument is 
an unsigned 16-bit value, and the lens driver is responsible for ensuring it is within a valid range.  

ZoomNarrow Sends the command to zoom in with an optional argument for the motor speed. See notes on speed range 
under ZoomWide.  

ZoomPos This sends the command to set the zoom motor to a specific position. This is called in response to an 
SLALensCommand. 

FocusStop Sends the command to stop the lens focus motor. This is called in response to an SLALensCommand. 

FocusNear Sends the command to focus on a closer position, with an optional argument for the motor speed. The 
speed argument is an unsigned 16-bit value, and the lens driver is responsible for ensuring it is within a 
valid range.  

FocusFar Sends the command to focus or a further position with an optional argument for the motor speed. See 
notes on speed range under FocusNear. 

FocusPos Sends the command to set the focus motor to a specific position. This would be called in response to an 
SLALensCommand. 

CmdPassthrough Can be used to pass other commands through to the lens that are not part of the basic set of focus, zoom, 
commands. The passthrough command is called in response to SLALensCommand. 

FocusAuto If there is no built-in auto focus capability, do not implement it or return SLA_NOP and the default 
implementation of SLA Auto Focus will be used. This could also be used to implement a custom auto focus 
algorithm or enable lens built in auto focus, in this case also make sure SLA_SUCCESS is returned.  

RequestStatus Requests the zoom and focus position from the lens. This is called regularly by the built in SLA Auto Focus 
algorithm, but also on command. When the data is received it should be sent out using 
UpdateStatusCallback.  

Reset Forces the lens to perform a reset. This would be called in response to an SLALensCommand. 

NUC Commands the camera to do a NUC if such a feature exists. Currently none of the SLA supported lenses 
have this feature. If this feature is not needed return SLA_SUCCESS. 

CustomCommand Intended for backwards compatibility with SLLensMode lensMode 128 - 255. SightLine recommends using 
CmdPassthrough instead. However, if using an interface that is sending older lensMode commands, 
implement this function to send this data to the lens. 

4 Developing Lens DLL 

The next sections cover the following processes: 

• Downloading and installing the example code. 

• Moving files to the target hardware. 

• Connecting to the target hardware and building the DLL. 

• Configuring VideoTrack to use the new DLL. 
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4.1 Installing Example Code 

Download the ARM Processor Code Examples package from the Example Code page on the SightLine 
website. Launch the installer and follow the installation prompts.  

An overview of relevant files is shown in Table 2. 

Table 3: Lens DLL Development Files 

File Description  

lens_dll/sllens_public.h 
Public interface for lens DLL development. Any custom lens drivers must meet this 
interface.  

lens_dll/slNopLensCtrl.h 

lens_dll/slNopLensCtrl.cpp 
Source code for SLNopLens driver. This is primarily SLATrace statements instead of real 
implementations. 

lens_dll/slHitachiLens.h 
lens_dll/slHitachLens.cpp 

Included as an example build. This is the same source code used by the SightLine Hitachi 
lens DLL and not built as part of the examples. 

ARM/SLAArmExamples.tgz 
Compressed file to be used for development on the 4000. Includes SLNopLens driver 
and build scripts. 

workspace/SLALensDLL1500 Example workspace used to build SLNopLens driver for 1500. 
workspace/SLALensDLL3000 Example workspace used to build SLNopLens driver for 3000. 

4.2 Build DLL - 4000-OEM 

Copy examples to 4000-OEM using WinSCP: 

1. Open WinSCP and login to the board. 

 

2. Navigate to the folder where the ARM example is installed: C:\SightLine Applications\SLA-
Examples-Arm ***\ARM\  

3. Copy the file SLAArmExamples.tgz to /home/slroot/ on the 4000-OEM.  

4. Use Tera Term to establish an SSH session to the 4000-OEM. Use the username and password: 
slroot. 

 

https://sightlineapplications.com/example-code/
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5. Extract the samples by running the following command: 

SD> tar -xvf SLAArmExamples.tgz 

6. Navigate to the lens_dll directory SD> cd SLAArmExamples/lens_dll. 

7. Build the example driver using the build script SD> ./buildLensDll.sh. 

8. The output of this step will be an example lens DLL slCustomLens.so.  

9. Copy the custom lens DLL to the lens directory SD> cp slCustomLens.so /home/slroot/sl/bin/lens/. 

4.3 Build DLL - 1500-OEM and 3000-OEM 

Building the DLL on the 1500-OEM and 3000-OEM can be done from Windows using Code Composer 
Studio.  

 The following procedure assumes the customer has read EAN-ARM-Development-1500-3000-OEM, 
and has set up a system as outlined in the Preparation section.  

1. Open the Code Composer Studio application. 

2. Select Workspace C:\SightLine Applications\SLA-Examples-Arm ***\workspace\. 

3. Select View » Project Explorer. 

4. Select File » Import. 

5. Expand General. Select Existing Projects into Workspace and click Next. 

6. In the Import Projects dialog click Browse and navigate to (C:\SightLine Applications\SLA-Examples-
Arm ***\workspace\).  

7. Select the desired project directory (SLALensDLL1500 or SLALensDLL3000) and click Finish. 

8. The project can now be built in debug or release using Project » Build All menu option. 

 

Figure 2: Importing a Project 

 

http://sightlineapplications.com/wp-content/uploads/EAN-ARM-Development-1500-3000-OEM.pdf
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Build notes: 

• A predefined CCS 5.x preferences file (ccs_eclipse_preference.epf) is in the workspace folder. Import 
this file via the Import dialog. Expand General and select Preferences. 

• When importing preferences ensure that Import all is selected, and no other options are checked. 

• Change between debug and release builds by right clicking on the project and selecting Build 
Configurations » Set Active. 

• The DLL slCustomLens.so or slCustomLensDebug.so should automatically be copied to the board by 
the PostBuild**00.bat file if the  SL_**00_IP is set up according to EAN-ARM-Development-1500-
3000-OEM. It will be placed in the correct lens folder automatically.  

4.4 File Naming Syntax 

All lens DLLs should use the same naming scheme <<filename>>.so with the following guidelines: 

• No spaces in the file name. 

• Filename including extension should be less than 128 characters. 

• Files should be placed in the lens folder, which is in the same directory as the VideoTrack 
application. 

• Paths are not required when specifying the file name in the SLALensParameters message: 

▪ Correct: MyLens02_03_04.so 

▪ Incorrect: MyLens02 03 04.so 

▪ Incorrect: ./lens/MyLens02_03_04.so 

4.5 Configure and Load DLL 

Once the lens DLL has been transferred to the hardware it can be configured and loaded as described 
in section 3 of EAN-Lens-Focus-Control. 

5 Lens DLL Troubleshooting     

Issue  Recommendation 

Lens DLL not listed 
 

Verify the DLL has been copied to the Target. DLLs must be placed 
in the lens folder. 

Verify Lens DLL file name syntax. 

 

 

 

http://sightlineapplications.com/wp-content/uploads/EAN-ARM-Development-1500-3000-OEM.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-ARM-Development-1500-3000-OEM.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-Lens-Focus-Control.pdf
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6 Custom Autofocus 

 IMPORTANT: Custom autofocus is only available on the 4000-OEM and 1750-OEM with Version 1 
of the Lens DLL and greater. It must be used with software version 3.6.x or higher. Previous 
methods of SightLine and custom autofocus are deprecated with this version. 

SightLine offers source code for two autofocus algorithms that can be integrated into the lens DLL. 
These algorithms can be used in their original form and, starting with version 3.6.x software, they can 
be customized using the CustomAutoFocusParameters (0xB5) command. Additionally, they can serve 
as a starting point for creating custom autofocus solutions. 

6.1 DLL Version 1 

New in software version 3.6.x and above.  

SightLine has provided two autofocus algorithms and control logic as example code to be used as part 
of the lens DLL. To achieve this goal and ensure maximum flexibility for users, SightLine has added new 
functions in sllens_public.h dealing with autofocus. For more information, see Developing Lens DLL. 

Table 4: Key Functions, Version 1 

Function Description When VideoTrack calls 

SetCustomAFParameters* This passes a CustomAutoFocusParameters struct saved in 
the parameter file into the DLL, to be passed into the auto 
focus object.  

After receiving 
SLACustomAutoFocusParameters SVP 
command. 

GetCustomAFParameters* Gets the autofocus parameters stored in the AutoFocus 
object to send back to VideoTrack.  

After receiving GetParameters, ID = 
SLACustomAutoFocusParameters. 

ZoomTrackFocus Sends the command to track focus through zoom. Can be 
done with the camera or by using Zoom Tracking.  

After setting zoomTrackFocus in 
SLALensParameters. 

FocusMetric* Passes the focus metric calculated by VideoTrack into the DLL 
to be used by the auto focus object. This command is not 
directly reachable by external applications and is only called 
from within VideoTrack. 

Once a frame if calibration, autofocus, or 
Focus Telemetry is enabled. 

CustomAutoFocusOn* Used by VideoTrack to see if the custom autofocus is running. 
Not implementing this correctly when using a custom 
autofocus may result in undefined behavior. This command is 
not directly callable by external applications. 

To check if the custom autofocus is 
running, and after receiving 
GetParameters: ID= SLACurrentLensStatus.  

CustomAutoFocusBreak* Used by VideoTrack to tell the custom autofocus to stop. Not 
implementing this correctly when using a custom autofocus 
may result in undefined behavior. This is not directly 
reachable by external applications. To stop a custom 
autofocus, use FocusStop, which will result in VideoTrack 
calling this function.  

To cancel the custom autofocus operation 
and when a FocusStop command is sent 
using SLASetLensMode=Focus Stop (ID=6) 

*Denotes functions that must be implemented in the DLL for autofocus to function. 

 The struct SLALensParameters_t has been changed as of Version 1. SLACustomAutoFocusParameters_t has been added. See the 
corresponding IDD entries for details. 

6.2 AutoFocus Loop 

The lens DLL contains an autofocus object that can be called by functions in sllens_public.h. When the 
autofocus object is initiated, it creates a thread to process lens information and a focus sharpness 
metric passed in from VideoTrack. The autofocus then calculates a new command based on the 
algorithm being used and sends it to the lens. The lens is then moved to the focus position with the 
highest focus metric when the algorithm ends.  

https://sightlineapplications.com/releases/IDD/current/struct_s_l_a_custom_auto_focus_parameters__t.html
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While autofocus is running, VideoTrack requests the lens status once per frame. The DLL is responsible 
for passing this information to the autofocus object.  

 

Figure 3: Autofocus Loop 

6.2.1 Autofocus Steps 

For each frame, a request for the focus motor position is sent to the DLL. Additionally, a focus 
sharpness metric is passed to the autofocus class of the DLL. A step is considered complete when both 
a focus position update and a focus metric are available. If new updates arrive while waiting for one of 
the values, the step will replace the available value. 

6.3 Modify DLL to Include Autofocus 

To use autofocus, it must be instantiated as an object in the lens class that extends SLLensPublic. This 
object has member functions that the DLL must call. The autofocus file does not need to be changed to 
work, but modifications can be made for a customized autofocus. See Autofocus Algorithms for more 
information. 

Example projects are available that show how to integrate autofocus into a lens DLL. To view all the 
lens code needed for autofocus, search for AF in an example file such as StingRayNightCrawler.cpp.  

Table 2 lists these functions and instructions on how to implement them. 

Table 5: Public Autofocus Functions - Version 1 

Function expected by AutoFocus DLL calling function Implementation Details 

AutoFocus::setLens SLLensPublic constructor 
Instantiate autofocus object with new and 
call in the lens constructor. 

AutoFocus::FocusAuto SLLensPublic::FocusAuto 
Entire lens calling function can be copied 
directly from example code. 

AutoFocus::SetParameters SLLensPublic::SetCustomAFParameters 
Entire lens calling function can be copied 
directly from example code. 

AutoFocus::GetParameters SLLensPublic::GetCustomAFParameters 
Entire lens calling function can be copied 
directly from example code. 

AutoFocus::FocusMetric SLLensPublic::FocusMetric 
Entire lens calling function can be copied 
directly from example code. 

Video Track 
On VSync frame update: 

• Calculates focus metric. 

• Sends request status to lens. 

Lens Focus Position  

Request Status 
Command 

Autofocus.cpp 
• Checks focus and position values 

received from DLL thread. 
• Sends commands to lens to 

change/or speed as needed. 

Commands to Change 
Direction and Speed 

DLL Lens File 
• Requests position and reads from 

port until position is provided from 
lens. 

• Passes focus metric to autofocus. 

Frame 

Focus 
Metric 

Focus Metric 

Lens Controlled 
Thread 

Autofocus 
Controlled 

Thread     
Camera Body 

and Lens 
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(Public Autofocus Functions - Version 1 table continued) 

AutoFocus::AutoFocusRunning SLLensPublic::CustomAutoFocusOn 
Entire lens calling function can be copied 
directly from example code. 

AutoFocus::AutoFocusBreak SLLensPublic::CustomAutoFocusBreak 
Entire lens calling function can be copied 
directly from example code. 

AutoFocus::UpdateLensPos Various 
Call this after the call for update lens status 
of the lens. 

AutoFocus::Cleanup SLLensPublic::Cleanup 
Call within the cleanup command of the 
lens. 

6.4 Focus Position and Focus Metric Offset Calibration  

There is often a delay between when VideoTrack receives a Vsync frame and when it receives the 
corresponding focus position. This delay can pose challenges for faster autofocus implementations or 
lenses with narrow zoom ranges, where even small changes in focus position can greatly affect the 
focus quality. 

To address this issue, the calibration process involves scanning through the focus range while 
continuously receiving focus position updates from the lens. It positions the motor at the specific 
positions for which it has received focus metrics, waits for a few frames at each position, and then 
requests the lens for the focus position. Upon completion of the calibration process, two focus curves 

will be obtained, as shown in Figure 4. 

 

Figure 4: Focus Metric Offset Calibration Curves 

The X-axis represents the steps of the calibration, and the Y-axis represents the focus metric for that 
step. The calibration step attempts to calculate the offset for these two graphs to be used to account 
for the focus position update delay.  

To calibrate this offset using Panel Plus: 

1. From the Lens tab in Panel Plus click the Autofocus Params and Calibration button to open the 
Autofocus and Calibration Settings dialog.  

2. In the Calculate Frame Offset Calibration section set the correct start and end focus values. 

3. Click Calculate to begin the calibration process. 
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Figure 5: Frame Offset Calibration 

focusCalibStart: The starting focus position of calibration. This must be the farther value. 

focusCalibEnd: The ending focus position of calibration. This must be the nearer value. 

frameOffsetMult8: Represents the focus value obtained, measured in eighths of a step. It is worth 
noting that steps here are approximately proportional to the frequency of focus position updates 
received. 

Behavior:  

During this calibration step, the program will sweep through the requested focus range from the far 
(start) to the near (end) focus position using the current focus motion speed, recording each focus 
position and the associated focus metric received by VideoTrack. The program will then move the lens 
to each of the recorded focus positions, wait, and obtain the true focus metric for that focus position. 
Finally, it will calculate the offset to the nearest eighth between these two curves. 

To ensure the best performance during calibration, the scene should have a focus metric curve that is 
shaped like a bell, with one area in sharp focus and the other areas steadily decreasing in focus. Noisy 
scenes can cause the calibration to be inaccurate. There is an option to specify a start and end focus 
position to ensure the curve is bell-shaped.  

6.5 Autofocus Algorithms 

The AutoFocus.cpp file contains two algorithms for autofocus: Seek and Scan. The Seek algorithm is 
designed to quickly find a nearby focus position. The Scan algorithm has more tunable parameters and 
can be used when the focus peak is further away from the current focus position. 

The Seek and Scan selections are available in the Method drop-down menu in the Lens tab under the 
Autofocus section.  

6.5.1 Seek Algorithm 

 

Figure 6: Seek Algorithm 

This algorithm is based on the hill-climbing autofocus algorithm. The Seek algorithm in AutoFocus.cpp 
calculates a suitable autofocus speed based on the VSync period of the lens. It then commands the lens 
to focus either near or far based on the previous focus metrics of the frame.  
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The algorithm takes in the following two parameters to adjust the autofocus speed and sensitivity: 

• rateAdjust: Adjusts the automatically calculated speed of the lens. The value range is 0 to 255, 
where 100 is the default speed of motion. 

• changePercent10ths: Adjusts the sensitivity to focus metric change in 10ths of a percent. The value 
range is 0 to 255 with a default of 40 (equivalent to 4% change). 

6.5.2 Scan Algorithm 

 

Figure 7: Scan Algorithm  

The autofocus algorithm used in this software is based on the Rule-Based Autofocus Algorithm 
developed by N. Kehtarnavaz et al. This algorithm locates the focus peak by adjusting the speed of the 
lens based on changes in the focus metric value.  

The algorithm moves the lens to an initial position and then switches between three different speed 
modes (fine, mid, and coarse) based on the likelihood of finding the focus peak in the current focus 
position area. Coarse mode moves the lens the fastest, but if fine mode has already been reached then 
the algorithm will assume the focus peak has been found and will end the search. 

This algorithm is highly flexible and has many tunable parameters that can significantly impact 
autofocus behavior, enabling users to configure it for either a fine-grained local search or an expansive 
global search, depending on their needs.  

• nInitialSteps: The number of steps the algorithm takes to move to an initial (focused far) position 
before beginning the focus search. During the initial step, the lens will move at the speed specified 
as the coarse speed (5 is the default). A small value (3-5) is typically sufficient to move to an area 
that encompasses the focused position.  

• FineSpeed, MidSpeed, CoarseSpeed: The speed to command the lens when it is in Fine, Mid, or 
Coarse mode. Fine mode should have the lens move the slowest, as it is the most likely to contain 
the focus peak.  

• FineThresh: The ratio of change from the previous metric to the current metric required to switch 
to the corresponding mode. Value is a percent out of 255. A higher number means the metric must 
change more steeply to trigger a switch to fine mode. This value should be changed if the lens is 
moving too fast when the focus peak is reached, or if it reaches fine mode when the focus peak is 
far away. 

• CoarseThresh: The ratio of the current metric compared to max metric seen, which is required to 
switch to coarse mode. A higher number means a smaller difference is required to switch to coarse 
mode. This value can be changed to make the algorithm end earlier or later, or to make the lens 
move faster when the focus peak is far away. 
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• CdownMax: How many sequential decreases in value are required for the algorithm to consider the 
focus value truly decreasing in order to switch to mid mode from fine mode. A default value of 4 is 
almost always appropriate. 

• RateAdjust: Same parameter that controls Seek but interpreted differently. Because the focus peak 
becomes narrower as a lens is zoomed, RateAdjust will allow for automatically decreasing 
FineSpeed, MidSpeed, and CoarseSpeed based on the zoom value of the lens. A higher number 
corresponds to slower speeds when zooming in. 255 = decrease the speed in exact proportion to 
the remaining zoom range. 0 = do not change speed based on zoom level. 

6.6 Non-SVP-based Autofocus Parameters and Customization  

To enhance the readability and customization of the autofocus functionality, the autofocus source 
code file includes several configurable parameters at the top. These parameters can be modified 
according to specific requirements. However, it's important to note that re-compiling the autofocus is 
necessary for these parameter changes to take effect. 

For instance, the STOP_TRAILING_FOCUS_MOTION flag can be set to true if the intention is to terminate the 
scan algorithm when the focus metric ceases to change. In most scenarios, options and numerical 
values typically do not require adjustments, and it is primarily the SVP parameters that significantly 
influence performance. 

6.7 Tracking Focus Through Zoom (BETA) 

New in 3.6.x software. 

SightLine allows users to track focus while zooming by using pre-configured values for the most 
focused positions, known as trace curves. These curves can be created manually or using the Zoom 
Track Curve Generation tool in the Autofocus and Calibration Setting dialog window. It is 
recommended to generate curves for multiple distances from the focused object. 

 

Figure 8: Trace Curves 

Figure 8 displays three trace curves, each manually generated for different distances: approximately 3 
meters, 10 meters, and 500 meters. Each line on the graph represents the optimal lens position that 
ensures maximum focus at each zoom level. 

To set the name of the trace curve file use the CustomAutofocusParameters (0xB5) command with the 
fileName option specified.  

https://sightlineapplications.com/releases/IDD/current/struct_s_l_a_custom_auto_focus_parameters__t.html
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Alternatively, the file name can be specified in the Zoom Track Curve Generation section in the 
Autofocus Calibration Settings dialog. After entering the name, select Send to save it to the board. 

 

Figure 9: Configuring Trace Curve Settings 

When VideoTrack is restarted, it will automatically load the trace curve file. The file is then used to 
calculate new focus positions whenever the Track Focus box is selected in the Zoom section of the Lens 
tab and the Zoom Position command is used. 

 

Figure 10: Send Command to Track Focus Through Zoom to VideoTrack 

 IMPORTANT: Currently, only tracking through zoom using the Zoom Position command is 
supported. 

6.8 Creating Trace Curves (BETA) 

New in 3.6.x software. 

VideoTrack can automatically create trace curves using the Autofocus and Calibration Setting dialog. 
VideoTrack will command the lens to collect a total of 30 zoom and focus samples, which will be added 
to a specified file on the SD card. 

To use this calibration: 

1. From the Lens tab select Autofocus Params and Calibration.  

2. In the Zoom Track Curve Generation section specify the zoom position range for sample collection 
(30 samples will be taken). 

3. Specify a file name in the File Name field to save the trace curve. 

 A new file name will be created if it does not exist. 

4. Click Send to store the trace curve file in VideoTrack as the currently selected trace curve file. 

5. Click Add a Curve to start the sample collection process.  

 Because the custom autofocus calculates the focus of the whole ROI window, it is important that 
the object be focused upon be the central object in the ROI window. 
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A zoom range can also be specified to increase sample density in certain zoom ranges. Currently, these 
would need to be added manually to an existing curve by editing the trace curve file.  

To manually add a trace curve to a file, find the maximally focused position for an object at various 
zoom positions. It is best to gather more data in areas of high zoom and when objects are closer to the 
lens. 

The format of the curves should be: 

<number of samples>: 

z:<comma separated list of zoom values> 

f:<comma separated list of focus values, matching to the zoom values in 

above list> 

<number of samples>: 

z:<comma separated list of zoom values> 

f:<comma separated list of focus values, matching to the zoom values in 

above list> 

Each curve should be separated by a blank line as shown in the example in Figure 11. 

 

Figure 11: Contents and Location of Example Trace Curve File 

7 Questions and Additional Support  

For questions and additional support, please contact SightLine Support. Additional support 
documentation and Engineering Application Notes (EANs) can be found on the Documentation page of 
the SightLine Applications website.  

 

mailto:support@sightlineapplications.com
https://sightlineapplications.com/documentation/
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